Microsoft Access Databases:
Database Creation and Data Entry

Unit: Technology
Problem Area: lllustrate Basic Database Management

Lesson: Databases: Database Creation and Data Entry

B Student Learning Objective. Instruction in this lesson should result in students
achieving the following objective:

Create a database and enter data into it.

B Resources. The following resources may be useful in teaching this lesson:

E-unit(s) corresponding to this lesson plan. CAERT, Inc. http://www.mycaert.com.

Chapple, Mike. “Databases for Beginners,” Lifewire. Accessed Jan. 21, 2019.
https://www.lifewire.com/databases-for-beginners-1019643.

Cook, Ken and Laurie Ulrich Fuller. “How to Build a New Database in Access 2016,” Dum-
mies. Accessed Jan. 21, 2019. http://www.dummies.com/software/microsoft-office/
access/how-to-build-a-new-database-in-access-2016/.

“Create a New Database,” Microsoft. Accessed Jan. 21, 2019. https://support.office.com/
en-us/article/create-a-new-database-32alealc-al155-43d6-aa00-fO08cd1a8f0le.

“Create Database Using Microsoft Access With 6 Amazing Steps,” EDUCBA. Accessed Jan.
21, 2019. https://www.educha.com/creating-database-using-microsoft-access/.
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H Equipment, Tools, Supplies, and Facilities

v" Overhead or PowerPoint projector

v Visual(s) from accompanying master(s)

v/ Copies of sample test, lab sheet(s), and/or other items designed for duplication
v’ Materials listed on duplicated items

v Computers with printers and Internet access

v~ Classroom resource and reference materials

B Key Terms. The following terms are presented in this lesson (shown in bold italics):

blank database

data entry

database

database form

database management system (DBMS)
Datasheet View

New tab

relational database

template

VVYVYVYVYVYVYY

M Interest Approach. Use an interest approach that will prepare the students for the
lesson. Teachers often develop approaches for their unique class and student situations. A
possible approach is included here.

Have students search for the phrase “database management” on a job Web site
such as Career Builder at http://www.careerbuilder.com. How many pages of job
openings exist? View the last page of the results. Notice that there are several
job openings that don’t have “database management” in the job title, but it is in
the job description. Discuss the need for database management to organize
large volumes of data into meaningful reports.
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CONTENT SUMMARY AND
TEACHING STRATEGIES

L L TYS G7-H8 Create a database and enter data into it.

Anticipated Problem: How is a database created using Microsoft Access? How is data
entered into a database?

|. Database creation and data entry

A database is a large, organized collection of information, usually held in a computer
memory for rapid search and retrieval. A database management system (DBMS) is
software that handles storage, retrieval, and updating of data in a computer system.
Microsoft Access is an example of DBMS software. Access is the most commonly
used relational database program for students and small businesses. A relational
database (RDB) is a collection of multiple sets of data, organized into tables that
communicate and share information. The data is indexed to make relevant
information easier to find.

A. DATABASE CREATION: Microsoft Access Backstage View is a starting point to
create a new or open an existing database. To get to Backstage View, click on the
File tab. Backstage View displays the New tab. The New tab is an option that
provides two primary ways for an Access user to create a new database. The user
can choose to use either a database template, or a blank database.

1. Template: A template is a ready-to-use database that contains all the tables,
queries, forms, macros, and reports needed to perform a specific task.
Microsoft Access templates are available to track issues, manage contacts, or
keep a record of expenses. Some templates contain a few sample records to
demonstrate their use. In addition to the templates that are included with
Access, users can find many more templates on http://www.Office.com. To cre-
ate a database using a template, Microsoft Office Support suggests the
following steps:

a. Step one: With database software open, on the File tab, click Close.
Backstage view displays the New tab.

b. Step two: Several sets of templates are now available in the New tab,
some of which are built-in to Access. Download additional templates from
http://www.Office.com.

c. Step three: Select the desired template.

d. Step four: Access suggests a file name for the database in the File Name
box. The user may change the file name. To save the database in a
different folder from the one displayed below the file name box, click the
folder image, browse to the desired folder to save it, and then click OK.

e. Step five: Click Create.

Lesson: Microsoft Access Databases: Database Creation and Data Entry
Page3 € www.MyCAERT.com

Copyright © by CAERT, Inc. | Reproduction by subscription only. | L620299


http://www.Office.com
http://www.Office.com

f.

Step six: Access creates a database from the template chosen, and then
opens the database. For many templates, a form is displayed for data
entry. If the template chosen contains sample data, delete each record of
sample data by clicking the record selector (the shaded box or bar just to
the left of the record), and then clicking Delete in the Records group on
the Home tab.

Step seven: To begin entering data, click in the first empty cell on the form
and begin typing. Then, use the Navigation Pane to browse for other
offered forms or reports. Some templates include a navigation form that
allows the user to move between the different database objects.

2. Blank Database: An Access blank database is a start-from-scratch document

in which the user creates unique tables, forms, macros, etc. Blank database
is the best option if the user has very specific design requirements, or has
existing data that must be accommodated or incorporated. To create a data-
base from scratch, the user is required to build tables, forms, reports, and
other database objects. This means entering, pasting, or importing data into
the table created by the new database. The process must be repeated with
any newly created tables. This is accomplished by using the Table command
on the Create tab, or by importing data from other sources and creating new
tables in the process. For this process, Microsoft Office Support suggests the
following steps:

a.
b.

o

f.

Step one: On the File tab, click New. Then, click Blank Database.

Step two: Type a file name in the File Name box. To change the location of
the file from the default, click Browse for a location to house the

database; browse to the new location, and then click OK.

Step three: Click Create.

Step four: Microsoft Access creates the database with an empty table
named ‘Tablel,” and then opens Tablel in Datasheet view. The cursor is
placed in the first empty cell in the Click to Add column.

Step five: Type to add data or to paste data from another source.

Step six: Enter data in Datasheet view. Datasheet View is a display of the
data in the database, arranged in rows and columns. This grid is similar in
appearance to an Excel spreadsheet. The process is designed to be very
similar to working in an Excel worksheet. The table structure is created
while data is entered. When the user adds a new column to the datasheet,
a new field is defined in the table. Access automatically sets each field’s
data type, based on the data entered by the user.

B. DATA ENTRY: Data entry is the process of entering information into a computer or
other electronic device. This process can be done manually or automatically by
using an electronic or mechanical device (e.g., a keyboard, mouse, stylus, touch
screen, or voice recognition software). Computers are often used for automated
data entry.

1. Forms: A database form is the primary method for computer users to enter
data to be stored. Users may enter, update, or delete data. Forms are usually
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easy for computer users to navigate. Anyone who has ordered merchandise
from a website has completed a database form. An order form calls for infor-
mation, such as name, address, payment method, etc. Database forms are
used to collect data, by phone, by personal face-to-face contact, or by elec-
tronic means. Common forms used for databases include sales records/pur-
chase invoices, employee or customer records, and inventory records.

2. Importance: As an important aspect of any organization’s success, data entry
requires attention to detail and accuracy. Business depends upon accurately
keyed data for analysis and decision-making. The information, provided
through the data entries, helps executives with day-to-day operations and
future planning. If information is incorrectly entered into the computer system,
the conclusions are skewed and inaccurate. Data entry minimizes administra-
tive burdens, improves productivity and time management, improves business
efficiency in general, and saves on costs.

3. Careers: Everybody that works in a business, from the lowliest clerk to the
Chief Executive Officer, performs data entry. “Data entry” is a broad term that
covers a number of occupations. In general, positions advertised as data entry
jobs usually require the least skill, and pay the least salary. Those jobs include
typists, word processors, transcribers, coders, electronic data processors, and
clerks. The most commonly pursued professions in the area of database tech-
nology are those of database analysts, database administrators, and database
engineers. These positions pay significantly greater money than simple data
entry jobs. Other examples of occupations in the database technology field
include Database Developer, Research Analyst, Business Intelligence
Specialist, Data Modeler, and Big Data Administrator.

4. Directions: According to Microsoft Access Support, to enter data in a database
involves the following sequential steps:

a. Step one: Double click the desired table in the Navigation Pane.

b. Step two: By default, Access opens the table in Datasheet View (a grid
that resembles an Excel worksheet).

c. Step three: Click, or otherwise place the focus, on the first field desired to
use and enter data.

d. Step four: Press ‘TAB,’ then, use the Right or Left arrow keys, or click the
cell in the next field, to move to the next field in the same row.

e. Step five: To move to the next cell in a column, use the Up or Down arrow
keys, or click on the desired cell.

Teaching Strategy: Many techniques can be used to help students master this
objective. Use VM-A and VM-B to discuss database creation. Use VM-C to review the
Steps to enter data into a database. Assign LS-A to have students demonstrate the
steps to create a simple database.
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Review/Summary. Use the student learning objectives to summarize the lesson.
Have students explain the content associated with each objective. Student responses can
be used in determining which objectives need to be reviewed or taught from a different
angle. If a textbook is being used, questions at the ends of chapters may also be included
in the Review/Summary.

Application. Use the included visual master(s) and lab sheet(s) to apply the
information presented in the lesson.

Evaluation. Evaluation should focus on student achievement of the objectives for the
lesson. Various techniques can be used, such as student performance on the application
activities. A sample written test is provided.

Answers to Sample Test:

Part One: True/False
1. T

X NOOAEWON
— =4 47T

Part Two: Completion

1. Datasheet View

New tab

database management system (DBMS)
blank database

data entry

template

L

Part Three: Short Answer

Business depends upon accurately keyed data for analysis and decision-making. The
information, provided through the data entries, helps executives with day-to-day
operations and future planning. If information is incorrectly entered into the computer
system, the conclusions are skewed and inaccurate. Data entry minimizes
administrative burdens, improves productivity and time management, improves
business efficiency in general, and saves on costs.
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Sample Test Name

Databases: Data Entry

» Part One: True/False
Instructions: Write T for true or F for false.

1. Microsoft Access Backstage is a starting point to create a new or open an existing
database.

2. Microsoft Access offers only one database template to perform one specific task.
Datasheet View is similar in appearance to an Excel spreadsheet.

When using a template to create a database, a user may not change the file name
suggested by Access.

5. After Access creates a database from a template, the user must then create a data
entry form.

6. A blank database is the best option if the user has very specific design requirements, or
has existing data that must be accommodated or incorporated.

7. A relational database (RDB) is a collection of multiple sets of data, organized into
tables that communicate and share information.

8. Data entry can be done by using a touch screen.

» Part Two: Completion
Instructions: Provide the word or words to complete the following statements.

1. A display of the data in the database, arranged in rows and columns, is called a/an

2. An option that provides two primary ways for an Access user to create a new database is
called
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3. Software that handles storage, retrieval, and updating of data in a computer system is a/an

4. The MS Access “start-from-scratch document” in which the user creates unique tables,
forms, macros, etc. is called a/an

5. The process of entering information into a computer or other electronic device, is called

6. A ready-to-use database that contains all the tables, queries, forms, macros, and reports
needed to perform a specific task is called a/an

» Part Three: Short Answer

Instructions: Answer the following.

Describe the importance of accurate data entry in a database.
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_vma |
DBMS

A database management system (DBMS) is software that
handles storage, retrieval, and updating of data in a

computer system. DBMS software controls the creation,
maintenance, and use of a database.

management
software database

data @ software
technology
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_vm-s
DATABASE CREATION

To create a database using Microsoft Access, the user can
choose to use either a database template, or a blank
database.
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_vmc
DATA ENTRY

Data entry is the process of entering information into a
computer or other electronic device.
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m Name

Database Creation

Purpose

The purpose of this activity is to create database tables using Microsoft Access

Objectives
1. Create product and supplier database tables using Microsoft Access.

2. Use available tutorials as necessary to assist in the database table creation.

Materials
¢ lab sheet
4 pen/pencil

¢ device with Internet access and Microsoft Access software

Procedure

1. TASK: Assume a company that sells baseball merchandise has the following products
from three different suppliers. The Data Chart contains the product and supplier
information. See the Data Types Table for settings information. Use all data to create the
following simple database tables:

a.
b.
c.
d.

Products Table: Design
Products Table: Data
Supplier Table: Design
Supplier Table: Data
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Item ID

Description

Units on
Hand

Cost

Data Chart

Supplier
Code

Selling Price

Supplier Name

Supplier
Telephone

5953 Shorts 10 $14.95 $19.95 AC Al’s Clothes 616-555-9228
6343 Sweatshirt 9 $27.45 $34.95 AC Al’'s Clothes 616-555-9228
7810 T-shirt 32 $9.50 $14.95 AC Al’s Clothes 616-555-9228
3683 Coasters 12 $7.45 $9.00 BH Beverage Holders 317-555-4747
4563 Coffee Mug 20 $1.85 $4.75 BH Beverage Holders 317-555-4747
4593 Glasses 8 $8.20 $10.75 BH Beverage Holders 317-555-4747
7930 Travel Mug 11 $2.90 $3.25 BH Beverage Holders 317-555-4747
3663 Baseball Cap 30 $10.15 $18.95 LG Logo Goods 517-555-3853
5923 Jacket 12 $44.75 $54.95 LG Logo Goods 517-555-3853
6189 Sports Towel 24 $3.25 $6.75 LG Logo Goods 517-555-3853
Data Types Table
Setting Data Type Size

Text (Default) Text or combinations of text and numbers, |Up to 255 characters or the length set by the

as well as numbers that don’t require calculations, |FieldSize property (whichever is less). MS
such as phone numbers. Access reserves no space for unused portions

of a text field.

Memo Lengthy text or combinations of text and numbers. | Up to 65,535 characters. (If the Memo field is
manipulated through DAO and only text and
numbers [not binary data] will be stored in it,
then the size of the Memo field is limited by
the size of the database.)

Number Numeric data used in mathematical calculations. To | 1, 2, 4, or 8 bytes (16 bytes if the FieldSize

learn more about setting the specific Number type, |property is set to Replication ID)
see the FieldSize property topic.

Date/Time Date and time values for the years 100 through 8 bytes

9999.
Currency Currency values and numeric data used in 8 bytes
mathematical calculations involving data with one to
four decimal places. Accurate to 15 digits on the
left side of the decimal separator and to 4 digits on
the right side.
AutoNumber | A unique sequential (incremented by 1) number or |4 bytes (16 bytes if the FieldSize property is
random number assigned by MS Access whenever a | set to Replication ID)
new record is added to a table. AutoNumber fields
can't be updated. To learn more, see the
NewValues property topic.
Yes/No Yes and No values and fields that contain only one |1 bit
of two values (Yes/No, True/False, On/Off).
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N O

10.

11.

12.
13.

Divide the Data Chart information into two tables: Products and Suppliers.

Start Access.

From the New File task pane, click ‘New Database.’

Name your new database “baseball” (in the folder in which you normally save your
work).

Select ‘Create table’ in Design View.

In Design View, enter the field names, select a data type, and enter a description for
each field. (Refer to the following page for design and data information.) Entering a
description makes the database more understandable to another person who will be
using this database.

In the Field Properties area, enter the field length for each of the text type fields. Use
Help to view other available field properties.

While the Item ID field is selected, click the ‘Primary Key button’ to designate that
field as the primary key. At least one field must be the ‘primary key.” This is the field
that will contain unique information for that record. [NOTE: In the Projects table, no
two products have the same Item ID, so this would be a good choice for the primary
key. Likewise, no supplier has the same Supplier ID, so that would be the primary key
for the supplier table.]

Click the “View button’ to toggle between the Design and the Datasheet views. In
Datasheet view, enter the data.

Enter a new record in the products table. (Be sure to use one of the three supplier
codes.)

Save your work.

Share your database tables with your instructor as directed.
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LS-A: Teacher Information Sheet

Database Creation

Products Table: Design

Field Name Data Type Field Length Primary Key?
[tem ID Text 4 Yes
Description Text 15
Units on Hand Number
Cost Currency
Selling Price Currency
Supplier Code Text 2

Products Table: Data

Description Units on Hand Selling Price Supplier Code
5953 Shorts 10 $14.95 $19.95 AC
6343 Sweatshirt 9 $27.45 $34.95 AC
7810 T-shirt 32 $9.50 $14.95 AC
3683 Coasters 12 $7.45 $9.00 BH
4563 Coffee Mug 20 $1.85 $4.75 BH
4593 Glasses 8 $8.20 $10.75 BH
7930 Travel Mug 11 $2.90 $3.25 BH
3663 Baseball Cap 30 $10.15 $18.95 LG
5923 Jacket 12 $44.75 $54.95 LG
6189 Sports Towel 24 $3.25 $6.75 LG
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Supplier Table: Design

Field Name Data Type Field Length Primary Key?
Supplier Code Text 2 Yes
Supplier Name Text 20

Supplier Telephone Text 12

Supplier Code

Supplier Table: Data

Supplier Name

Supplier Telephone

AC Al's Clothes 616-555-9228
BH Beverage Holders 317-555-4747
LG Logo Goods 517-555-3853
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